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This resource book is the second volume publication on Community 
Mapping and Participatory Geographic Information System (PGIS) 

which aims to equip the users with the necessary knowledge, attitude 
and skills on this subject area. It is intended for land rights defenders, 
institutions advocating for land rights, development practitioners, 
and communities to defend their rights to land and the sustainable 
use of natural resources.

Inspired by the pioneering work of the Philippine Association for 
Intercultural Development, Inc. (PAFID) in PGIS mapping in the 
country, this publication is designed to impart the key concepts 
of community mapping and the basics of PGIS, with the view that 
the application of PGIS technology contributes to securing legal 
recognition of the indigenous communities over their traditional 
territories and resources. 

This volume is designed to impart on the “how-tos” for the production 
of digital maps useful in advancing the land rights agenda of rural 
communities, particularly indigenous communities and smallholder 
farmers in Southeast Asia. The publication is divided into three major 
sections:

Chapter 1: Mapmaking Concepts, Principles and Practices discusses 
the art and science of mapmaking. It shows the types of maps, its 
uses, and the processes and tools needed to produce such maps for 
advocacy purposes. 

Chapter 2: Presentation of Maps Using Google Earth Tour and 
Powerpoint highlights the means of presenting the finished maps to 
both the intended and wider audience utilizing tools available in this 
information age.

Chapter 3: Using Maps for Advocacy shows what needs to be 
done to ensure that the maps produced become powerful tools for 
advocating the cause of land rights defenders. 

FOREWORD
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This resource book is not prescriptive but aims to contribute to the 
empowerment of communities in protecting and defending their 
right to land. As this resource book is a general guide on PGIS, readers 
need to be mindful of the legal procedures and requirements for the 
submission of community maps for registration and legal recognition. 
In the Philippines, the PGIS has been useful in establishing and 
enhancing the right to self-determination by the indigenous tribes 
over their ancestral domains, through the opportunity provided by 
the Indigenous People’s Rights Act (IPRA). 

The examples used in this publication are outputs of the PAFID- 
organized four-day training course on “GIS Tools for Development 
Workers: Advocacy, Agrarian Reform and Indigenous Peoples” 
(18-21 April 2017; Quezon City, Philippines), as well as examples 
of communities who have actually generated and utilized maps in 
support of their advocacies. 

At the same time, members of the International Land Coalition (ILC) 
have been working towards a common agenda in the Philippines 
through the National Engagement Strategy (NES) Platform. This 
resource book is part of the strategies of the Philippines NES to 
enhance the basic sectors’ capacities to demand and defend their 
rights and natural resources. It also contributes to the initiative of 
the Asian NGO Coalition (ANGOC) and Land Watch Asia campaign in 
sharing of experiences, approaches, and tools on enhancing tenurial 
security of the rural poor.

This resource book is a work-in-progress, and shall welcome feedback 
from practitioners to further enhance the information, the mapping 
methods and processes presented in the publication.
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CHAPTER 1:
MAPMAKING CONCEPTS, 

PRINCIPLES, and PRACTICES

Cartography is the science and art of map-making. Science 
 because it concerns with the discovery and organization of 

knowledge using information system technologies such as Geographic 
Information System (GIS) which has the capability for capturing, 
managing, manipulating, and visualizing geographic information. It 
is an art because mapmaking requires imagination, creativity and 
innovation.

A map is a graphic representation or scale model of spatial concepts. 
It is a means for conveying geographic information easily understood 
by people, regardless of language or culture. A map is a powerful tool 
to visualize the situation. It helps us to locate where the problematic 
areas are and provide useful information as basis for policy formulation 
and development interventions that are tailor-fitted to the needs of 
the local people. 

Map makers must learn the basic elements of a map, understand the 
planning process, and possess skills designing and production based 
on cartographic principles and participatory geographic information 
system (PGIS)  tools.
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ELEMENTS OF A MAP

A map has the following cartographic elements as shown in red boxes 
in Figure 2:

n	 Title – clearly state what the map shows and where the map 
	 is located
n	 Orientation – must show North arrow
n	 Legend – be precise and clearly define categories and 
	 meaningful symbols 
n	 Reference System – Datum + Projection + Coordinate 
	 System
n	 Scale – represents the ratio of the distance between 
	 the points on the Earth and the distance between the two 
	 corresponding points on the map

Figure 1. Basic knowledge and skills in mapmaking.
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n	 Vicinity Map – indicating Graticules, Scale Fraction and 		
	 Scale Bar
n	 Citations – indicating data sources both geographic and 
	 attribute data 
n	 Publication – citing the author and date of map publication

PREPARATION FOR MAPMAKING

In preparation for making a map, it is important to consider the 
following factors, namely: (a) context, (b) target audience, (c) 
cartographic standard and common practice, and (d) cartographic 
code of ethics.

Context: Maps are made according to purpose and depending on the 
people’s needs, issues, and concerns. For land rights advocates, the 
purpose and content may be influenced by community context which 
usually revolves around land tenure issues and resources for IPs as 
shown in Figure 3.

REFERENCE 
SYSTEM

Datum, Ellipsoid, 
Projection

GRATICULES

VICINITY MAP
Graticules, Scale 
Fraction, Scale 

Bar

CITATION
Data Sources

PUBLICATION
Author, Date

LEGEND MAP TITLE ORIENTATION

SCALE

Figure 2. Cartographic elements of a map.
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Figure 3. Land tenure issues and resources for indigenous peoples.
Adapted from CBMIS for Community Trainers and Organizers, TEBTEBBA Foundation
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Target audience: The users will influence how a map should appear, 
both in content/substance and format. Target audience may include, 
among others, IP communities, government officials, and local 
executives. 

Participatory mapping can be used as a strategy for awareness raising, 
education and community organizing. The map can strengthen 
community’s arguments for land rights advocacy during dialogue and 
negotiations with government officials and other stakeholders.

Figure 4. Indigenous peoples as the target audience of the map.
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Participatory mapping can be used for visualization and the 
development of Ancestral Domain Sustainable Development 
Protection Plan (ADSDPP) for indigenous communities.

With the objectives in mind, the appropriate methodology that can 
be identified is PGIS Mapping through 3-D Modelling techniques 
combined with GIS Technology.

Figure 5. Participatory maps used as advocacy material during dialogues with government.
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Cartographic standards common practice:

a.	 Generalization is the process of reducing  certain  details in a 
map in a meaningful way. Maps contain a certain level of detail 
depending upon its scale and purpose. It is important that 
geometric and attribute accuracy as well as the presentation 
quality of the map must be maintained.

b.	 Graphic Variables refer to the different graphic characters or 
symbols that may render different perceptions to the map 
readers which can affect the map design in terms of choosing 
Font Size, Value, Texture, Color, Orientation, and Shape. 

Figure 6. Participatory mapping as a tool for visualization and development of the indigenous 
community’s ADSDPP.



19

c.	 Methods and Types of Map-users will influence the way 
maps will be projected. Basically, there are three types of 
maps: (1) General Purpose Maps, (2) Thematic Maps, and (3) 
Topographic Maps.

Cartographic Code of Ethics:

Figure 7. Cartographic code of ethics.
Source: Dodge, M., Cartographic Principle: Map Design
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MAP PRODUCTION

Spatial Data Collection

Map production starts with data collection from their source either a 
questionnaire or input from an electronic device. 

Data capture is the conversion of geographic coordinate data (through 
field survey using Global Navigation Satellite System (GNNS) device or 
smartphones with GPS capability) into a computer-readable format. 

What is GPS and GNSS?

The wider application of GIS 
has been accompanied by 
the development of enabling 
technologies such as the 
Global Positioning System 
(GPS), a satellite-based 
navigation system made up 
of a network of satellites 
that orbit the Earth and send 
a signal to GPS receivers such 
as the Garmin Oregon 650, 
giving a precise location, speed and altitude.

Since 1983, GPS technology has 
revolutionized field mapping. 
Inexpensive GPS receivers can 
provide reasonably accurate 
information about the latitude, 
longitude and altitude of the 
user’s position at anytime and 
anywhere in the world. GPS 
methods have been integrated 
in many applications areas 
such as forestry, geology and Figure 9. Global position system receivers.

Figure 8. Network of satellites orbiting the Earth. 
Source: PAFID (Zingapan, K., 2017)
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community development. GPS technology has been widely used 
worldwide for community mapping, useful for land use planning, and 
management of natural resources.

Today, the GPS system provides critical positioning capabilities to 
military, civilians and commercial users. The US government created 
the system, maintains it, and makes it freely accessible to anyone 
with a GPS receiver.

Incidentally, the Global Navigation Satellite System (GNSS) was 
developed by other nations for military services and civilians. The 
GNSS is essentially a satellite system used to pinpoint the geographic 
location of a user’s receiver across the globe. Hence, there are now 
more satellites available and enabling positions to be fixed more 
quickly and accurately other than the GPS developed by the US 
military.  

At present, there are at least six GNSS systems currently in operation. 
These are the: i) US Global Positioning System (GPS); (ii) Russian 
Federation’s Global Orbiting Navigation Satellite System (GLONASS); 
(iii) Europe’s Galileo; (iv) China’s BeiDou Navigation Satellite System 
now known as Compass; (v) India’s Global Indian Navigation System 
(GINS), and (vi) Japan’s Quasi-Zenith Satellite System (QZSS).

Figure 10. Global Navigation Satellite System.
Source: PAFID (Zingapan, K., 2017)
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Each of the GNSS system employs a constellation of orbiting satellites 
working in conjunction with a network of ground stations. GNSS 
precision varies depending on what particular technologies are being 
used.

How a typical hand-held GPS works

1.	 GPS is based on triangulation from satellites. The GPS 
adhere to the principle of 
triangulation to locate the 
user through calculations 
involving information from 
a number of satellites. Each 
satellite transmits coded 
signals at precise intervals. 
The receiver converts signal 
information into position, 
velocity, and time estimates.

2.	 GPS receivers measure distance from satellite using travel 
time of radio signals.

3.	 To measure travel time, GPS needs precision and accurate 
timing.

4.	 Along with distance, the receiver must know exactly where 
the satellites are in space. Satellite location, high orbits 
and careful monitoring are the key to get accurate location 
expressed in Latitude and Longitude.

5.	 Users must correct any delays the signal experiences 
as it travels through the atmosphere. A Satellite-Based 
Augmentation Systems (SBAS) can transmit corrections and 
integrity data for GPS/GNSS system to improve accuracy to 
15 meters.

Figure 11. Triangulation of satellites.
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Figure 12. Satellite-based Augmentation Systems.

GPS/GNSS Data Capture using 
Garmin GPS Receiver: An Example

1.	 Turn-on the GPS Garmin receiver.
2.	 The datums and grid preferences can be reached from the 

main menu by selecting the navigation setup options. 
3.	 Set the navigation datum, the navigation grid, and the 

user units. 
	 •	 For GPS navigation and geophysical use, a datum 
		  (such as WGS 84) which is a model of the Earth is 
		  used as reference point from which the receiver can  

	 measure things. 
	 •	 The GPS defines a three-dimensional model that 
		  “describes mathematically the shape of the Earth, the 
		  location of the center and the location on the 
		  surface that represents the starting point for 
		  measuring” (DePriest, 2013).
4.	 In the Application Drawer, select the Satellite icon to 

open the Satellite Page and wait for the GPS receiver to 
acquire four or more satellites. Once it finds a position 
lock, the display will change to show a location (expressed 
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in degrees Longitude and 
degrees Latitude), an 
accuracy estimate, and an 
elevation. 

Once the GPS has a position 
lock, numbers appear on the top 
pane of the satellite page (see 
Figure 13). 
	 •	 The string of numbers 
		  on the top left corner is 
		  the GPS measurement 
		  for the Latitude of the 
		  location, expressed 
		  in degrees-minutes-
		  seconds. 
	 •	 The series of numbers 
		  below the Latitude 	

	 is the GPS measure-
		  ment for Longitude of 	

	 the location, also 	
	 expressed in degrees-

		  minutes-seconds. 
5. 	 The number on the upper 

right corner is an accuracy 
assessment of the GPS 
measurement. The number indicates the size of a circle 
(radius) inside of which the true position lies. A smaller 
circle indicates a more accurate measurement. Good survey 
conditions will give an accuracy of 10 meters or less.  If 
possible, wait until the number for GPS accuracy falls to 10 
meters or lower before starting the data capture.

6.	 Capturing locational information in the field is usually done 
using Waypoints. Mark your waypoints in the Waypoints 
Page of the GPS receiver, assign a unique name, and click 
Done.

7. 	 Repeat steps 4 to 6 whenever a data will be captured in 
specific locations until all spatial data are generated.

Figure 13. GPS receiver screen showing 
the satellite page.

Figure 14. GPS receiver screen showing 
GPS measurements.
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How to download, view and save GPS/GNSS data

Download GPS Data to Computer
1.	 Plug the GPS receiver in a USB port on the computer
2.	 Open Garmin in BaseCamp 
3.	 In the left-hand panel under Devices, select the folder named 

Internal Storage 
4.	 In the left-hand pane; under Internal Storage, look for the GPS 

waypoints and tracks you wish to export.
•	 Use the Pan and Zoom  buttons to move around 

the map view
•	 To select, click on the Select  button and draw a box 

surrounding all waypoints and tracks you wish to export
•	 For multiple selections, hold down the Ctrl key and click 

on the names of the GPS waypoints and tracks to be 
exported

Export as a Garmin GDB file as backup copy of your GPS survey
5.	 Click on File> Export> Export Selection

•	 Select a folder to store your GPS data
•	 In the panel for File name, type a name for your survey 

data
•	 In save as type, ensure that Garmin GPS Database Files 

(*.gdb) is selected
•	 Click on Save

Export as a GPS exchange Format (*.gpx) file for viewing in Quantum 
GIS

6.	 Ensure that the waypoints and tracks to be exported are still 
selected
•	 Click on File> Export> Export Selection
•	 Select the folder for your GPS data archive
•	 In the panel for File name, type a name for your survey 

data
•	 In Save as type, ensure that GPS exchange Format (*.gpx) 

is selected
•	 Click on Save

Export as a KML 2.2 Document v2 [*.kml] to view your survey in 
Google Earth

7.	 Ensure that the waypoints and tracks to be exported are still 
selected 
•	 Click on File> Export> Export Selection
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•	 Select the folder for your GPS data archive
•	 In the panel for File name, type a name for your survey 

data
•	 In Save as type, ensure that KML 2.2 Document, v2 

(*.kml) is selected 
•	 Click on save

8.	 If you wish to export all data inside the GPS receiver, click on 
File> Export> Internal Storage

View GPS Data in Garmin BaseCamp and Google Earth
9.	 In the left-hand panel under Internal Storage, right-click on 

the GPS data you wish to view 
•	 Select Show on Map
•	 Use the mouse wheel to zoom in and zoom out of the 

map
•	 Use the Navigation buttons  to pan, zoom and 

select on the map shown
10.	 In the left-hand panel for Internal Storage, right-click on the 

GPS data you wish to view
11.	 Select Open

•	 This opens the Properties Page which shows the data for 
each GPS feature

12.	 Open Google Earth
•	 Ensure that the computer is connected to the Internet
•	 In Google Earth, click on File> Open and browse to the 

folder of your GPS data archive
•	 Select the KML file for your GPS survey
•	 Use the mouse wheel to zoom in and zoom out of the 

map. Press and hold the Shift key to rotate the view. 
Press and hold the Ctrl key to tilt the view and show the 
elevation profile. 

•	 To reset the view, type ‘R’ on the keyboard.

	
MAP DESIGNING

If Cartography is the science and art of mapmaking, Geodesy is 
the science of accurately measuring and understanding the Earth’s 
geometric shape, orientation in space, and gravity field. In map 
designing, the users must bear in mind the following principles as 
shown in Figure 15.



1.	 Geographic Reference System (GRS)
n	 The first important spatial concept in mapping technology is 

to communicate and locate objects using spatial reference 
system which has the following characteristics: (a) stability, (b) 
the ability to show points, lines and areas, and (c) the ability 
to measure length, size and shape (Dale and McLaughlin, 
1988). 

n	 GRS has three categories  namely: (a) geographical coordinate 
system, (b) rectangular system, and (c) non-coordinate 
system.

a.	 Geographic coordinate systems – the coordinates of any 
location on the Earth surface can be defined by latitude 
and longitude. Lines of longitude, commonly called 
meridians, are drawn from pole to pole as shown in 
Figure 16.
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Figure 15. Principles of map designing.



The starting point for these lines is called the prime meridian that 
runs through Greenwich, England.

b.	 Rectangular coordinate systems – most of the spatial 
data available using GIS are in two-dimensional form. 
This coordinate referencing system to locate any object 
point is called rectangular coordinate system. 

c.	 Non-coordinate systems – this GRS provides spatial 
references using a descriptive code rather than a 
coordinate, such as, postal codes, which are numeric in 
nature (e.g. UK and Canada postal codes).

•	 Maps have a reference starting point otherwise 
known as a datum.

•	 Datums are based on a model of the Earth called 
a reference ellipsoid and enable all the various 

Figure 16. Geographic coordinates system.
Source: PAFID (Zingapan, K., 2017)

28

Figure 17. Greenwich meridian.
Source: Geographic Grid (M. Anji Reddy, 2008)

Greenwich meridian – the longitude 
of reference, i.e., 0° east or west. It 
passes through the English town 
of Greenwich, a suburb of London.  
Basically, the prime meridian is the 
starting or zero point for angular 
measurements, east and west. The 
lines of latitude lie at right angles 
to lines of longitude, and run par-
allel to one another. That is, each 
line of latitude represents the circle 
rounding the globe.



projections in a GIS work together to give an accurate 
picture of the Earth.

•	 Datums are a reference surface that is defined by:
i.	 Ellipsoid – described by its origin and coordinate 

system
ii.	 Survey – a survey of points and lines tying the 

ellipsoid to point on Earth (e.g. WGS 1984 Datum; 
Luzon 1911 Datum; Everest 1830 Datum)

•	 Maps have a reference grid — a geographic data 
model that represents information as an array of 
uniform square cells. 

•	 Each grid cell has a numeric value that refers to the 
actual value of a geographic phenomenon at that 
location (e.g., population density or temperature) or 
it indicates a class or category (e.g., the enumeration 
area identifier or soil type).

•	 The reference grid helps the user navigate the map 
and links the spherical earth to the map projection.

•	 GIS is grid-based technology with the following 
functionalities as shown in Table 1.
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Source: DeMers, M., GIS for Dummies

Table 1. GIS functionalities.



2.	 Map Projection
n	 Maps are a flat model of a spherical Earth as shown in Figure 

18.
n In principle, objects of the Earth’s surface are distorted when 

a map is projected on a flat surface either in size, shape or in 
relative location (Maling, 1980)

n The globe is in 3D and a flat surface is in 2D. All 2D maps have 
some “distortion”.

n	Distortions of areas could lead to incorrect measurements. 
Hence, map projections are needed so that areas can be 
preserved.

n	There are many types of  “Map projections” to try and 
preserve some of the following:
a.	 Area (e.g. Lambert Azimuthal)
b.	 Angles and bearings (e.g. Mercator projection)
c.	 Shapes and Sizes (e.g. Robinson)
d.	 Distance and Direction (e.g. Sinusoidal)

n	 To transfer the image of the Earth and its irregularities on to 
the plane surface of a map, three factors are involved namely: 

30

Figure 18. Map Projection.
Source: PAFID, Zingapan, K., 2017)



a.	 Geoid is a rendition of an irregular spheroidal shape. The 
variations in gravity are accounted for at this level. The 
observations made on the geoid are then transferred to 
a regular geometric reference surface.

b.	 Ellipsoid or a datum with ellipsoid. Many countries and 
organizations have calculated a variety of ellipsoids over 
the years mainly due to different observations on the 
geoid from different points upon the Earth.

c.	 Projection is the geographical relationships of the 
ellipsoid, still in a three-dimensional form, are 
transformed into two-dimensional plane of a map.

n	 Majority of projections are based upon cones, cylinders and 
planes as shown in Figure 19.

n	 Each of these formats have advantages and disadvantages 
in terms of distortions and accuracy. Every flat map 
misrepresents the surface of the Earth in some way. 

n	 As a general rule, parts of a map can show one or more, but 
never all of the following: true shapes, true directions, true 
distances, and true areas. 
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Figure 19. Cones, cylinders, and planes as bases of the majority of projections.
Source: Geoid   Ellipsoid - Projection- Relationship (M. Anji Reddy, 2008)



3.	 Map Scale

n	 Map scale is the ratio between the reduced depiction on the 
map and the geographical features in the real world. 

n	 Map scales are the ratio of the distance between two points 
on the map and the corresponding distance on the ground. 

n The scale may be expressed in three ways and the pictorial 
representation are:
a.	 Fractional scale: If two points are 1 km apart in the field, 

they may be represented on the map as separated by 
some fraction.

b.	 Graphic scale: This scale is a line printed on the map and 
divided into units that are equivalent to some distance.

c.	 Verbal scale: This is an expression in common speech 
such as “four centimeters to a kilometer” and “an inch to 
a mile”. This common method of expressing a scale has 
the advantage of being easily understood by most map 
users. 

n	 To calculate scale, use the following formula: map scale = 
map distance/Earth distance

32

Figure 20. Map scale. 

Source: PAFID (Zingapan, K., 2017)



n	Remember to convert everything into the same units. Then 
convert back to what you were asked.

n Map scale has a huge impact on GIS analysis.
n	Maps are broadly classified on the basis of two criteria 

namely:
a.	 Scale

•	 Small-scale maps cover large areas with little detail 
e.g. A world map. Scale - 1:250 000

•	 Large-scale maps cover small areas with lots of detail 
e.g. A map of Toronto. Scale - 1:50 000

b.	 Contents and purpose in terms of thematic contents
•	 Physical maps considered as small-scale maps, or 

cultural map
•	 Thematic maps like vegetation maps, transportation 

maps, land use land cover maps, and remotely 
sensed imagery

33

Figure 21. Graphic scale                        
Source: Three Different Types of Scale (M. Anji Reddy, 2008)



4.	 Design Principles and Rules

USING AVAILABLE OPEN SOURCE GIS SOFTWARE

In the past, the cost of GIS Software often discourages land rights 
defenders from digitizing critical spatial information. Today, various 
open source GIS software are available for free for land rights 
defenders allowing them to develop GIS databases of the maps of 
their community partners. One of the more popular open source GIS 
software is Quantum GIS (QGIS).
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Table 2. Design principles and rules

Source: Dodge, M., Cartographic Principle: Map Design



What is QGIS?

Quantum GIS (QGIS) is a user friendly Open Source Geographic 
Information System (GIS) that runs on Linux, Unix, Mac OSX, and 
Windows. QGIS supports vector, raster, and database formats. It lets 
the user to browse and create map data on their computer. It supports 
many common spatial data formats (e.g. ESRI shapefile, geotiff). QGIS 
supports plug-ins to do things like display tracks from the GPS units. 
QGIS is a free downloadable Open Source software.

QGIS is an operating system designed to capture, store, manage, 
manipulate, visualize, model, analyze, and display spatial data. It 
is an enabling tool that support GIS as an integrating technology 
that provides a platform for studying spatial relationships. It makes 
connections between activities based on geographic proximity 
that had often been unrecognized. Lastly, it offers new insights and 
explanations that are vital to understanding and managing resources 
(Goodchild and Kemp, 1990; Cowen, 1990). 

Database management and data processing of spatial information 
can now be easily processed using QGIS.

Data Base Management refers to unique issues in the maintenance 
of spatial data such as technical error or level of accuracy, input, and 
storing data; retrieving data; and metadata. Data management is 
one of the key issues in determining the usability of spatial data. The 
application of QGIS software has been used by PAFID for many years.

Another important operation is Data Processing which is the 
restructuring of data to increase their usefulness and add values for 
particular purpose. It involves calculation, analysis, comparison, data 
manipulation, sorting, searching, and transformation of data. Some 
of its important functions are summarizing, computing averages, 
graphing, creating charts and visualizing data.  When answering 
questions that may not be explicitly stated in the data, this is called 
data analysis.
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Relevance of QGIS

QGIS is used for solving complex planning and management problems 
because it has the ability to investigate in terms of: (a) Locations – 
“where”, overlaps; (b) Quantities – “what”, lengths and areas, most 
and least; (c) Distances – scoping, proximity; (d) Distributions or 
densities – clustering, hotspots; (e) Discern Patterns – correlation, 
causality, random; (f) Trends – monitoring change or behavior 
through time, movement; and (g) Models – “what if”, scenarios, 
decision support systems. Hence, the QGIS can be applied in different 
fields, to wit:

•	 Medicine – origin case of GIS analysis
•	 Navigation – airplanes, cars, shipping
•	 Hazards – risk, vulnerability
•	 Networks – streets, electricity, transport 
•	 Land-use planning and land management
•	 Conservation
•	 Natural resources management – one of the first applications 

and driver of the development of modern GIS

Many governments in different countries across the globe are 
maintaining huge geographic database for analysis and make such 
information open to public use. 

QGIS can process geographic data from a variety of sources and 
integrate it into a map project which is interactive. On the computer 
screen, map users can data capture from the field using GPS Garmin 
receiver that provide spatial location. It can scan a map in any 
direction, zoom in or out, and change the nature of the information 
contained in the map. It organizes geographic data so that the user 
reading a map can select necessary data for a specific project or task. 
A thematic map has a table of contents that allows the reader to add 
layers of information to a base map of real-world locations.
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An important skill that land defenders should possess is the ability to 
validate the veracity of the tenurial instruments issued to them.  

Conflicts arise among various claimants regarding the actual location of 
the awarded lands. Often, the lack of spatial information exacerbates 
conflicts among stakeholders on ground. Hence, it is important that 
basic sectors have the ability to verify the information indicated in the 
formal instruments, for instance, the Certificate of Land Ownership 
Award (CLOA)1, they have received from the government. 

One way of validation is by plotting the lot description of a CLOA 
Transfer Certificate Title (TCT)2 in a map using GIS.

1	 A CLOA is a tenurial instrument issued by the Department of Agrarian Reform (DAR) 
to landless farmers.

2	 TCT is a document issued by the Registry of Deeds (ROD) that will process the 
generation of CLOA. It contains the geophysical location, measurement, registration 
number, and name of the owner of the land to whom its ownership was transferred 
to from the Republic of the Philippines.

Plotting CLOA

The following exercise was based on the actual CLOA. However, for 
security reasons, some elements of the map were replaced with fictitious 
names.

EXERCISE: CLOA TCT

Objective: To plot a CLOA TCT lot description

Research

1.	 Study the CLOA TCT document 
2.	 Find the general area where the CLOA is located:

•	 Province
•	 Municipality

3.	 Find the name of the “Tie Point”
•	 The “Tie Point” is  a named muhon or geodetic monument used 

to locate the CLOA TCT boundary corner marked “1” or Corner 
“1”. Tie Points are often Bureau of Land Location Monuments 
(BLLM), Barrio Boundary Monuments (BBM), Municipal 
Boundary Monuments (MBM), PRS92 monuments, and others.
These monuments are often named with Cadastre Numbers.
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4.	 Find the technical description of the “Tie Line” that connects 
Corner “1” of the CLOA to the “Tie Point” or named muhon:
•	 Bearing in degrees, for example, N25°25’W
•	 Distance in meters

5.	 Find the technical description of the CLOA boundary lines 
connecting the CLOA boundary corners:
•	 Bearing in degrees
•	 Distance in meters

PPCS-TM Zone or Projection Number
Refer to Annex 7 of DENR Memorandum Circular 2010-16 Manual on 
Land Surveys.

•	 Note the province where the CLOA TCT is located
•	 Check the PPCS-TM Zone for the CLOA TCT technical description

PRS92 Certification of Tie Point Coordinates
Go to the DENR Regional Office Land Management Service and request 
a PRS92 Certification for the CLOA TCT “Tie Point”. The Certification 
must show the following (sample attached):

•	 The name of the “Tie Point”
•	 The PRS92 coordinates of the “Tie Point” expressed as 

longitude and latitude in degrees, minutes, and seconds; and 
ellipsoidal height or height above the PRS92 ellipsoid (HAE) in 
meters

•	 The PRS92 coordinates of the “Tie Point” expressed as eastings 
and northings in meters; and geoidal height or mean sea level 
(MSL) in meters

•	 Certificate data and place; and name and signature of certifying 
officer

QGIS Settings
1.	 Open Quantum GIS. In the lower right corner, click on the Coordinate 

Reference System (CRS) icon

 
2.	 Set the following:
•	 Check the box next to ‘Enable on the fly’ CRS transformation
•	 Next to ‘Filter’, type PRS92 
•	 From the research, select the correct PPCS-TM Zone for the 

CLOA TCT, for example, PRS92 / Philippines zone 4 (EPSG: 4324)
•	 Click OK
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3.	 In the main menu, click on Settings > Options and select the 
Digitizing tab 

4.	 Set the following:
	 Feature creation

•	 Uncheck the box next to ‘Suppress attributes pop-up windows 
after each created feature’

	 Rubberband
•	 Line width = 1

	 Snapping
•	 Default snap mode: To vertex
•	 Default snapping tolerance: 50 pixels
•	 Search radius for vertex edits: 10 pixels

	 Vertex markers
•	 Check the box next to ‘Show markers only for selected features’

5. 	 In the main menu, click on Settings > Snapping Options
•	 Set the Snapping mode to All layers
•	 Check the box next to ‘Enable topological editing’
•	 Click OK

6. 	 Ensure that the following Plugins are installed:
•	 Azimuth and Distance version 0.9.3
•	 QuickMapServices

7. 	 Save your QGIS file by clicking on Project> Save in the main menu

Prepare the traverse import text file
1. 	 Refer to the PRS92 Certification of Tie Point Coordinates

•	 It is important for land rights defenders to possess the CLOA 
TCT as it provides the coordinates of the location of the 
awarded land. It must also be ensured that the document is 
validated by the government seal (see Annex A for a sample 
Certification of Tie Point Coordinates).

•	 Note the coordinates for the Tie Point of the CLOA TCT (see 
Figure 24):

Figure 24. Portion of the PRS92 Certification of Tie Point Coordinates showing the 
coordinates of the CLOA TCT.

2.	 Following is a sample lot technical description of a CLOA TCT :
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Figure 25. Sample lot technical description of a CLOA TCT.

•	 Type the technical description of the “Tie Line” and CLOA 
boundary lines in an Excel file using the following columns:

Tie Line 
and

 Boundary 
Lines

North 
Or 

South

Bearing

Degrees,

°

Bearing

Minutes,

‘

Bearing

Seconds,

‘’

East Or 
West

Distance, 
meters

“Tie Line” : 
“Tie Point” 
to Corner 

“1”

0-1
N 25 25 0 E 1305.31

1-2 N 19 3 0 E 66.84

2-3 N 34 37 0 E 138.97

3-4 S 75 25 0 E 228

4-5 S 15 32 0 W 189.36

5-1 N 77 3 0 W 277.8
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3. 	 Below is a sample of the traverse format used by the QGIS Azimuth 
Distance Calculator Plugin:

Figure 26. Sample traverse format used by 
the QGIZ Azimuth Distance Calculator Plugin.

4. 	 Use a text editor like Notepad to reformat the technical description 
for the Azimuth Distance Calculator Plugin. Copy the coordinates of 
the “Tie Point” (Corner 0) in the line after ‘startAt=’

startAt=TiePoint-X-Easting; TiePoint-Y-Northing;90
for example,
startAt=518259.215; 1213887.815;90

5. 	 The lot descriptions are also reformatted and inserted under [data] 
as below:

[data]
NorthOrSouth Bearing-DegreesD Bearing-Minutes’ 
Bearing-Second” EastOrWest;Distance;90

for example,
[data]
N 25D 25’ 0” E;1305.31;90

	 In the Excel file for the technical description of the Tie Line and 
Boundary Lines, the CONCATENATE function can be used to reformat 
the technical description, as below:

		  =CONCATENATE(NorthOrSouth,” “,
		  Bearing-Degrees,”D “,Bearing-Minutes,”’ “,Bearing-Seconds,””” 	

	 “,EastOrWest,”;”,Distance,”;90”)

6. 	 Alternatively, use the Excel file ‘QGIS traverse calculator template’ to 
reformat the entries for:
•	 startAt
•	 [data]
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7. 	 Copy-paste the entries into the Notepad file ‘QGIS traverse blank 
form’ and ‘Save-As’ the TCT traverse data to a new text file before 
closing Notepad. Ensure that no blank spaces follow the entries.

Create an empty polygon shapefile

1. 	 In QGIS, click on the New Shapefile Layer  and use the 
following settings:
•	 Type : Polygon
•	 Check that the Selected CRS is the PRS92 PPCS-TM Zone of the 

CLOA TCT for example, EPSG:3124, PRS92 / Philippines zone 4
•	 Below New field, add 8 new fields one after another using 

the settings below. Click on the ‘Add to fields list’ button 

 to add each New field :
Name Type Length Precision

Name Text data 200

SurveyPlan Text data 50

LotNumber Text data 100

ClaimNo Text data 100

TCTNo Text data 100

TiePoint-
Name

Text data 100

AreaSQM Decimal 
number

20 15

For mistakes, use the Remove field button 
•	 When done, click OK
•	 Next to File name, type a file name
•	 Next to Save as type, ensure that ESRI Shapefile is selected
•	 Click OK

2.	 In the Layers panel, select the new empty polygon shapefile and 

click on the Toggle Editing button 

3.	 Click on Plugins> Topography> Azimuth and distance
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Figure 27. Command box showing the Azimuth and Distance.

4.	 In the Azimuth and distance plugin, click on the Import List button 

•	 Select the Notepad file of the reformatted CLOA lot technical 
description and click Open

•	 Check on the box next to ‘As Segments’
•	 Below ‘Survey type’, check that ‘Boundary’ is selected
•	 Next to Arc Direction, select ‘Clockwise’
•	 Below ‘North type’, select ‘Default’
•	 Below ‘Distance units’, select ‘Default’
•	 Below Angle type’, select ‘Bearing’

•	 Click on the Draw button 
•	 Fill up the data for the TCT in the pop-up form and click OK
•	 Close the Azimuth and Distance plugin

5.	 Click on Settings> Snapping Options and use the following settings:
•	 Layer selection : Advanced
•	 Ensure the box next to the CLOA polygon layer is checked
•	 Set the snap mode to vertex
•	 Check that tolerance is set to 50 pixels
•	 Check that ‘Enable topological editing’ is enabled
•	 Check that ‘Enable snapping on intersection’ is enabled
•	 Click Ok
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6. 	 On the Attributes toolbar, click on the ‘Select Features’ button 

  and select the CLOA lot 

7. 	 On the Digitizing toolbar, click on the Node tool  
•	 Click the Node tool on the CLOA polygon until the Vertex editor 

pane is displayed. Use the Node tool or the Vertex Editor pane 
to select the nodes or vertices of the CLOA polygon. 

•	 In the Vertex Editor pane, note the coordinates for the “Tie 
Point” or Corner 0 and the CLOA Corner “1” which are entered 
in row 0 and row 1, respectively

•	 In the Vertex Editor pane, select Corner 0 and press ‘Delete’ on 
the keyboard to delete the Tie Point

•	 Check that the coordinates for the CLOA TCT Corner “1” are now 
displayed in row 0 of the Vertex Editor pane

•	 In the Map Navigation toolbar, click on the ‘Pan’ and ‘Zoom In’ 
buttons to zoom in on TCT Corner “1” which should now be 
displayed as row 0 in the Vertex Editor pane. 

•	 On the Digitizing toolbar, click on the Node tool  and click on 
the CLOA polygon until the Vertex Editor pane is again displayed

•	 In the Vertex Editor pane, check that the coordinates in the last 
row are identical to the coordinates of CLOA Corner “1”

•	 In the Vertex Editor pane, select the second-to-the-last row and 
press ‘Delete’ on the keyboard to delete the point (see Figure 
28):

                            
Figure 28. QGIS workspace showing the Vertex Editor pane.

•	 Once finished, click on the Save edits button  to save your 
edits

Calculate the area of the CLOA TCT
1. 	 Right-click on the polygon layer and select ‘Open Attribute Table’

•	 Click on the Field Calculator button   
•	 Check ‘Update existing field’ and in the box below, select 



Figure 29. Overlaying the plotted polygon in the Google Sattelite Imagery.

Figure 30. Creating the CLOA map in the ‘Print Composer’.
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AreaSQM
•	 Under the Search box, click Geometry and double-click on area
•	 Click OK

•	 Click on the Save edits button  to save your edits, then 

click on Toggle Editing button  to close the editing session

2.	 Click on Web> QuickMapServices>Google and select Google 
Satellite 

3.	 Use the Print Composer to create a CLOA map and save your QGIS 
document before closing QGIS.
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Data Output – refers to the method used to visually display analysis 
performed using GIS. Output can take many forms such as text, 
sound, tables of data, graphs, commands, etc. Depending on the 
form of output required, the data can be transmitted by a range of 
devices for presentation. 

	 Digital Map Production is a graphic representation or scale 
model of spatial concepts. It is a means for conveying geographic 
information. Figure 31 shows a sample Perimeter Map produced 
by Ms. Naungayan during a four-day GIS Training last April 16-19, 
2017 held at Brentwood Suite in Quezon City. The GIS Training 
was jointly organized by PAFID and ANGOC.

It is important that the output map be shown and validated with the 
farmer owners, and check whether the actual location of the CLOA is 
consistent with the coordinates indicated in the TCT.

In the example above, the CLOA is erroneously located in the ocean 
instead on land, showing an erroneous survey.

Figure 31. Sample Perimeter Map.
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Rhind (1977) enumerated several good reasons for computer map 
production, to wit:

n	 To make existing maps more at a quicker pace. 
n To make existing maps at a cheaper rate. 
n To make maps for specific user needs. 
n To make map production possible in situations where skilled 

staff are unavailable. 
n	To allow experimentation with different graphical 

representations of the same data. 
n	To facilitate map making and updating when the data are 

already in digital form. 
n To facilitate analysis of data that demand interaction between 

statistical analysis and mapping. 
n	To minimize the use of the printed map as a data store 

and thereby to minimize the effects of classification and 
generalization on the quality of the data. 

n To create maps like the 3-D type. 
n	To create maps in which selection and generalization 

procedures are explicitly defined and consistently executed. 
n Introduction of automation can lead to a review of the whole 

map-making process, which can also lead to savings and 
improvements.

Source: (M. Anji Reddy, 2008)

Moreover, converting the analog map to digital form is either 
by manual digitization or by scanning. Manual digitization is the 
commonly used technique for including analog data in a digital 
database.



48

Introduction 

Just like most Indigenous communities in Mindanao, the 
Subanen community in the Municipality of Bayog, Zamboanga 
Del Norte faces numerous challenges that threaten the 
integrity of their environment. Illegal gold mining activities in 
the town of Bayog have been going on for the past 45 years and 
small-scale miners have illegally claimed hundreds of hectares 
of lands, leading to  tremendous environment pollution. The 
illegal miners used cyanide, nitric acid, and other hazardous 
chemicals including mercury to process the gold ore. Tons of 
cyanide and mercury-laden mine wastes flow out freely from 
shallow ponds dug by the illegal miners damaging hundreds of 
hectares of fertile farmlands. What was even worse was the 
fact that the unabated illegal mining activities resulted into 
over 100 tunnels, which crisscrossed beneath the surface of 
the gold-rich mountains in the Subanen Ancestral Domain.

In 2006, in order to safeguard 
what remains of their 
traditional lands, the tribe 
submitted the application 
for a Certificate of Ancestral 
Domain Claim (CADC) covering 
land located in this town to 
the National Commission on 
Indigenous People’s (NCIP). 
The application covered 
22 barangays in Bayog: 
Dimalinao, Boboan, Depore, 
Pulangbato, Dipili, Kahayagan, 
Liba, Conacon, Bantal, Boboan, 
Deporehan, Sigacad, Balukbuhan, Matin-ao, Datagan, Camp 
Blessing, Kanipaan, Bonbonan, Depase, Matun-og, Baking and 
Canoayan. The Subanen knew that the road ahead would not 

A case of local  map production by the Subanen 
community in Bayog, Zamboanga del Norte, 
Philippines

Figure 22. Map showing the Municipality 
of Bayog, Zamboanga Del Norte, 
Philippines.
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be easy and they will have to respond to the challenges posed 
by those who had vested interests over their lands. 

To strengthen their advocacy for the recognition of their rights 
over their ancestral domains, the Subanen elders needed to 
produce evidence. The Subanen also needed to inform the 
public of the dangers posed by the illegal mining activities of 
the various ecosystems in the municipality.  

Mapping their Territory

With assistance from PAFID, the community constructed 
a Participatory 3D-Model. Through the P3DM, community 
members were able to generate spatial information on 
the extents of their traditional territory, their traditional 
management zones and land-uses of the Subanen domain.  
Furthermore, they were able to analyze and show the impacts 
of the illegal mining activities in their ancestral lands.

While the P3DM provided an excellent venue for the Subanen 
community to generate, analyze and present the state of 
their territory, the spatial information produced by the 
P3DM needed to be digitized and to be further analyzed in 
order for the Subanen to produce data and maps critical to 
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their advocacy.  Hence, it was decided that a training on the 
use of Quantum GIS an Open Source GIS Software would be 
conducted. Participants representing the villages in the domain 
claim would be nominated by the community. Initially, the 
trainees doubted their ability to cope with the demands of the 
training. They cited their limited educational status and their 
unfamiliarity with computers and GIS software. Furthermore, 
they shared the notion that mapping is the exclusive domain of 
professional engineers and that ordinary folks have no business 
trying it. 

The community nominated five Subanen participants; two 
NGO participants along with two NCIP trainees joined them. All 
participants had varying levels of familiarity with information 
technology as well as educational attainment. The training took 
a total of 12 days which were broken down into three separate 
sessions to enable the participants to examine and validate 
their work with the community using the P3DM.  Participants 
learned how to transfer the information from the P3DM to a 
digital image and the use of the on-screen digitizing utility of 
Quantum GIS. Furthermore, they were trained on the basics 
of map production including Geographic projection and Map 
layout. 

Results

After nearly a month, the Subanen participants were able to 
produce a complete map layout of their Ancestral Domain. 
The map had spatial information and thematic layers including 
hydrology, road networks, management zones, risk areas, the 
perimeter of the ancestral domain claim, the proposed no-
go zones, land-use and land cover. In a General Assembly, the 
map was later presented to the community members for final 
editing and validation. With minimal edits and comments, 
the map was resoundingly approved and endorsed by the 
community and formally adopted as the accurate and proper 
representation of their ancestral domains. Copies of the map 
were formally submitted to the Office of the Mayor, the DENR 
and other concerned agencies.

In 2015, the Subanen community was invited to participate and 
present their experience in PGIS in the Regional Conference of 
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the Catholic Aid for Overseas Development (CAFOD). Copies of 
their map were prominently displayed in the conference.

Lessons learned

The Bayog experience clearly showed that ordinary folks can 
learn basic GIS and will be able to create a simple spatial 
database and generate maps. Critical factors include that the 
training is properly designed and the trainers have the proper 
patience, understanding of the situation and fortitude to 
conduct the capacity building activity.

Figure 23. Land Use Map of the Bayog CADT area.
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The spread of social media such as Facebook into the rural areas 
has proven to be very effective breaking barriers and enabled 
ordinary people to remove their fears of digital technology. This 
is especially true with the younger generation who are very 
eager to learn and expand their knowledge in the field of ICT.

The use of the P3DM, along with the upscaling into Quantum 
GIS, is very sound illustration on the convergence of various 
PGIS tools and methodologies that can empower the people 
and increase their capacity to advocate and engage the more 
powerful sectors of society.

The whole PGIS exercise has enabled the Subanen to learn new 
technologies to strengthen their advocacy and has shown the 
greater public that they are able to adapt new technologies and 
learn skills that are more complicated. This has resulted into a 
very noticeable increase in local pride that is clearly shown in 
their engagements with the government and other sectors of 
society. They now proudly declare that they are mappers and 
that they have GIS practitioners in their ranks. n
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With today’s technology, advocacy has been evolving creatively 
and conveniently through the use of different medium. In 

terms of mapmaking, GIS data can be presented in a more innovative, 
mobile, and visually compelling form using Google Earth and Microsoft 
Powerpoint Presentation. 

Aside from their user-friendly attributes, both software programs 
offer basic functions that can be utilized in presenting maps. In 
terms of availability and accessibility, Google Earth application is 
downloadable online while Microsoft Powerpoint Presentation is 
accessible in desktops and laptops that have preinstalled Microsoft 
Office products. Google Earth is popular among mapmakers since 
it has advantages over some mapmaking methods. Google Earth 
gives instant up-to-date map data with three-dimensional visuals 
that are extremely detailed. It is available on a wide array of devices 
and in 45 languages. Lastly, Google Earth and Microsoft Powerpoint 
Presentation can be embedded in webpages. 

Using Google Earth in presenting advocacy map

Google Earth is a well-established, free desktop application that 
allows users to easily access all information from a three-dimensional 
map of the world. The kind of information that users can obtain from 
Google Earth varies, among others, from coordinates, elevation, and 
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street view of a certain location which also includes photos, videos, 
audio, and weather information. These features are utilized by users 
to create visualizations as a compressed video file or guided tour. 

However, the technological barrier across countries affects the quality 
of images and/or videos that can be viewed in Google Earth. Most 
developed countries offer more detailed image projections unlike 
other countries that have not obtained certain advancements in GIS. 

Google Earth is suited for advocacy maps simply because it has a 
history imagery feature. Historical imagery is used to see and analyze 
the changes happened and/or made over time to a certain location 
especially when observing the effects of a natural disaster or the 
evident changes in the landscapes. In addition, Google Earth allows 
users to render files that can be exported through different social 
networking sites (SNS). 

For advanced features such as GIS data import, it is recommended to 
use Google Earth Pro.

1.	 Features and uses of Google Earth
Using Google Earth is relatively simple and easy to navigate. 
Imagine creating a tour around a specific location. A tour consists of 
‘Placemarks’ or the points of interest (the user can add supplementary 
information about the placemark). These Placemarks are either 
added manually by the user or generated by Google Earth using 
‘Geocoding’ or importing a list of addresses that determine the 
Placemarks – allowing the user to create a route to connect all the 
generated Placemarks which will compose the ‘tour.’ The tour can be 
rendered as an audiovisual file.

2.	 Workspace of Google Earth
On the left side of the workspace, a ‘Search bar’ is located underneath 
the ‘Menu bar’. The ‘Search bar’ is used to locate coordinates, states, 
provinces, cities, and addresses. At the middle upper part of the 
workspace, the ‘Toolbar’ can be found and it contains the essential 
features in creating a tour. Some of the features include placemarks, 
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polygon, path, image overlay, and record a tour, among others. On 
the right side of the workspace, the user can find two navigational 
compass and a ‘Zoom’ tool. The first compass with an eye icon (Eye 
altitude) in the middle is used for scouting around the location, while 
the second compass is used for moving from one location to another. 
This compass guides the user in navigating through the map. The 
‘Zoom’ tool is used to view a more detailed image projection or to 
zoom out the map. On the bottom part of the workspace, image date, 
elevation, and coordinates of the location can be found (See Figure 
32).  More Google Earth tools and features will be tackled in the next 
sections. 
 

3.	 Historical Imagery
Historical Imagery is a useful tool for advocacy maps especially when 
forwarding political, social, and environmental issues. This feature 
allows users to view changes in specific landscape overtime. For 
example, one can use historical imagery to view the mining activities 
in Mindoro1  within a certain timeframe. 

Figure 32: Interface of Google Earth.

1 For the purpose of this Manual, Mindoro will be used as an example to demonstrate the 
procedures. Mindoro is located at the southwestern coast of Luzon Island, Philippines and is 
part of Region IV-B. The province is divided into Occidental Mindoro and Oriental Mindoro. 
Mindoro is the home of several Mangyan groups and is the cradle of Mt. Halcon and Mt. Basco.
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Step 1: In the ‘Search’ text box in the upper left-hand corner, 
enter ‘Mindoro’ and click ‘Search’ (see Figure 33).

Step 2: After viewing the area, click ‘Show historical imagery’ 
button in the upper middle area of the screen just above the map 
(see Figure 33).

Step 3: A scroll bar will appear on the top left of the screen in 
the map window which will be used to scroll through imagery 
obtained from specific dates within the preferred timeframe (see 
Figure 33).

 
Step 4: Use the imagery to observe, for example, the changes 
brought about mining activities in Mindoro.

4.	 Creating a Google Earth tour
In creating a guided tour, the following steps are essential to navigate 
the user accordingly to the chosen point of interest. For the first step, 
adding placemarks will determine the places to navigate to while 
embedding information will give context to the added placemarks. 
Once the placemarks are added along with their information, creating 
the route will stitch the tour together. To export the finished output, 
simply record the tour and save. 

5.	 Adding placemark
Placemarks represent points of interest in the tour. Placemarks are 
vital since they give description of each location which makes up the 
totality of the tour. Name of placemarks can be edited by the user 
according to the purpose of the tour. 

Figure 33: Historical imagery and scroll bar.
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Step 1: In the ‘Search’ text box in the upper left-hand corner, 
enter ‘Mindoro’ and click ‘Search’.

Step 2: Next, click ‘Add Placemark button’ in the toolbar on the 
upper middle side of the screen.

Step 3: In the ‘Google Earth new placemark’ window, select ‘Name 
field’ and type ‘Point A’ (this serves as sample name for the first 
target placemark); leave the other options as their defaults (see 
Figure 34).

Step 4: Leaving the window open, position the placemark over 
the target area. A yellow pin will appear, then drag it to position 
the ‘Point A’ placemark (see Figure 34).

 
Step 5: Click ‘OK’ to create the placemark. 

NOTE TO THE USER: To change the name, right click on the pin and 
select ‘Rename’. The location can only be modified when the ‘Edit 
Placemark window’ is open (see figure 35). To edit placemark, right 
click on the pin in the map or in the side bar and choose ‘Properties’ 
(see Figure 36.1). To select a symbol for placemark, click ‘Icon’ just on 
the right side of ‘Name field’ (see Figure 36.2). 

Figure 34. Adding placemark.
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6.	 Placemark description
The viewer navigating through the tour/map can see displayed 
information about the placemark by simply clicking the pin. Adding 
information on the placemark gives context to the viewer about what 
the tour is all about. 

Step 1: To add description, right-click the placemark and choose 
‘Properties’.

Figure 35. Editing placemark name.

Figure 36.1. Editing placemark properties.
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Step 2:  In the ‘Edit Placemark window’. click inside the description 
box and type description/information for ‘Point A’ (See Figure 37).

 
Step 3: An image can be added by selecting the ‘Add web image 
button’ and paste the URL/Link of the selected image.

7.	 Embedding information from the computer
Google Earth offers different options for adding images directly 
from the user’s computer. Inserting an image as a different object 
appears differently from linked images since the image appears to be 
‘floating’ above the Earth’s surface. To organize the placemarks and 

Figure 36.2. Pin Icons.
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images, there is an option to create folder to help keep track of the 
files. The default name of the folder is ‘My Places’. This folder collates 
placemarks, images, and, routes for the tour. 

Step 1: Double click on the created ‘Point A’ placemark. Google 
Earth will zoom into the view showing ‘Point A’ placemark on the 
map. Alternately zoom in and out using ‘+’ and ‘-‘.

Step 2: Add image by clicking on the ‘Add’ menu and select 
‘Photo’ (see figure 38).
 
Step 3: Once the ‘New photo overlay window’ opens, enter the 
image name. Adjust the image if necessary (see figure 39).

 
Step 4: Once adjustments has been made, select preferred image 
then click ‘Ok’.

Figure 37. Adding description on placemark.
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Figure 38. Adding photo on placemark straight from computer.

Figure 39. Browsing image file from computer.

62



Figure 40. Creating subfolders to organize images and description per placemark.

NOTE TO THE USER: To keep a placemark and the supplementary 
images together and separate from other placemarks, create a 
subfolder under ‘My Places’. To create a new folder, click on the ‘Add’ 
menu and choose ‘Folder’. Once the ‘New folder window’ opens, 
rename the folder to ‘Sightseeing Tour’ (this serves as sample name 
of the subfolder for ‘My Places’ folder) (see Figure 40). When the 
new folder is created, drag ‘Point A’ placemark and its supplementary 
image into the folder. 
 

In creating a tour, the user will need to add more placemarks. 
For example, the user will add ‘Point B’ placemark and ‘Point C’ 
placemark. This time, these placemarks will be added via ‘Geocoding’. 
‘Geocoding’ converts tabular data such as street addresses or 
longitude and latitude coordinates into georeferenced points which 
can be easily mapped. 

Using longitude and latitude coordinates

Step 1: On the menu bar, click ‘File’ then ‘Import’ (see Figure 41).
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Step 2: Browse for the CSV file to be imported and click ‘Open’.

Step 3: Once a box appeared, choose ‘Delimited’ located next to 
‘Field Type’.

Step 4: Choose ‘Comma’ then use the ‘Preview pane’ to ensure 
that imported data are correct and click ‘Next’.

Step 5: Uncheck the box which indicates “This dataset does not 
contain latitude/longitude information.”

Step 6: Select the fields in your spreadsheet that contain the 
‘Latitude and Longitude data’ (see figure 42.1) and click ‘Next’. 
Optional: Specify the type of each field in your dataset.

Figure 41. Importing CSV file for ‘Geocoding’.

Figure 42.1. Sample CSV file which contains the 
coordinates
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Step 7: Click ‘Finish’. Google Earth begins geocoding your data.

Step 8: To add description and image, simply repeat process in 
‘Placemark Description’.

NOTE TO THE USER: When entering longitude and latitude values, 
formats varies from DD MM SS.SSS degrees minutes and decimal 
seconds, DD.DDDD decimal degrees, DD MM.MMMM degrees 
and decimal minutes. Users can also use N, S, E, and W to specify 
directions.

Using street addresses

Step 1: On the menu bar, click ‘File’ then ‘Import’.

Step 2: Browse for the CSV file to be imported and click ‘Open’.
 

Step 3: Once a box appears, choose ‘Delimited’ located next to 
‘Field Type’.

Step 4: Choose ‘Comma’ then use the ‘Preview pane’ to ensure 
that imported data are correct and click ‘Next’.

Step 5: Check the box which indicates “This dataset does not 
contain latitude/longitude information.”

Step 6: Select “Addresses are broken into multiple fields.”

Figure 42.2. Sample CSV file which contains the street addresses (Retrieved from Google Earth).
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Step 7: Review the names to ensure the encoded data are correct 
under ‘Select Address Field(s)’ then click ‘Next’.

Step 8: Check the list of fields and the type of data selected for 
each then click ‘Back’.

Step 9: Click ‘Finish’. Google Earth begins to geocode the data. 

Step 10: To use a style template, click ‘Yes’ then select ‘OK’.

NOTE TO THE USER: Address data appear as icon in the 3D viewer 
and their properties can be edited. Users can only import addresses 
located within the United States, United Kingdom, Canada, France, 
Italy, Germany, and Spain. 

8.	 Create a route
In creating a tour, the goal is to form a route that connects all 
placemarks. On the other hand, the ‘Direction tool’ is used to navigate 
user from one placemark to another by car, bike, walking, or public 
transit. Likewise, it can be changed according to the user’s preference 
in navigating the tour. 

Step 1: Go to ‘Point A’ placemark. Above the map, click Add Path. 
To add a shape, click Add Polygon. To make a path or polygon into 
a 3D object, click ‘Altitude’.

Step 2: A “New Path” or “New Polygon” dialogue will pop up. 
Move the dialog box away before moving on to the next step.
 
Step 3: To draw the line or shape, click a start point on the map 
which in this case, ‘Point A’ placemark and drag.

Step 4: Click an endpoint to ‘Point B’ placemark. Then, enter 
description and properties and click ‘OK’.

Step 5: Repeat process in creating routes from ‘Point B’ to ‘Point 
C’ and so on. 
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NOTE TO THE USER: To measure distance and elevation of the 
placemarks, visit this link: https://support.google.com/earth/
answer/148134

9.	 Record an animated tour
For the last step, record a tour that goes through the created route 
in Google Earth’s 3D environment. An audio can also be added to the 
recorded tour. 

Step 1: In the ‘Layers panel’, turn on the preferred layers to be 
featured on the tour (e.g. 3D building, ocean, roads, weather, 
ocean, etc.) (see figure 43). 

 
Step 2: Click ‘Add’ then select 
‘Tour’ (see Figure 44), or in 
the bar above the globe, click 
‘Record’.

 
Step 3: To start recording, go 
to the lower left corner in the 
media player and click ‘Record/
Stop’ (see figure 45). Figure 43. Layers panel.

Figure 44. Add ‘Tour ‘option in the ‘Menu Bar’.
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Step 4: To record audio, click Microphone (See Figure 45).
 

Step 5: Navigate to each 
placemark on the route or go to 
the left-hand panel under ‘My 
Places’ and click a placemark 
to go to that location. Start 
from ‘Point A’ then to ‘Point B’ 
and so on. 

Step 6: When you finish 
recording, click ‘Record/Stop’. 
In the lower right corner, a 

media player will appear, and your tour will start playing.

Step 7: To save the tour, in the media player, click Save   (see 
Figure 46). In the box that opens, enter a title in the “Name” field. 

 

Step 8: To add more information about the tour, use the 
‘Description’ and ‘View tabs’. Click ‘OK’.

NOTE TO THE USER: The tour is saved in KMZ file but later can be 
converted to an AVI file which can be uploaded in the web.

Figure 45. ‘Record.’ ‘Stop.’ and ‘Microphone’ 
icon located at the lower left bottom of the 
map.

Figure 46. Once the tour is completed, save the tour under ‘My Places’.
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Presenting dynamic maps using Microsoft Powerpoint Presentation

Another innovative way in presenting advocacy maps is through a 
Powerpoint presentation. Powerpoint presentation animates static 
images from QGIS and converts them into a dynamic map. In using 
dynamic maps, each layer is dissected to emphasize information or 
legends depicted in the map such as watershed, mining tenement, 
forest, among others.

Adding a dynamic map into a Powerpoint slide

Step 1: Upon opening a PowerPoint file, click the dropdown 
menu on the Powerpoint ribbon then select ‘More Commands’ 
to customize the quick access toolbar (see figures 47 and 48).

Step2: Once the ‘Powerpoint Options’ tab appeared, choose ‘All 
Commands’ in the dropdown menu (see figure 48). 

 

Figure 47. Dropdown menu to customize quick access toolbar.
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Step 3: Under ‘All Commands’, find the ‘Set Transparent Color’, 
click ‘Add’ then ‘OK’ (see Figures 50 and 51).

Step 4: To copy the map layer from the QGIS software, click 
‘Project’ on the menu bar then select ‘Save as image’.

Step 5: Open and copy the saved map layer image that will be 
featured in the presentation. 

Figure 48. ‘More commands’ under the customize quick access toolbar.

Figure 49. ‘All commands’ display all available functions that can be displayed in the quick 
access toolbar.
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Step 6: Go to the Powerpoint slide to paste the map layer image 
then select the figure (see Figure 52). 

 
Step 7: Click ‘Set Transparent Color’ command located on the 
Powerpoint ribbon (see Figure 53). 

Figure 50. ‘Set transparent color’ makes the image overlays.

Figure 51. Select ‘Add ‘then ‘OK’ to add the function into the quick access toolbar.
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Step 8: Apply the command to the map layer image by clicking 
the image (see Figure 55). 

 

Step 9: Repeat the processes until all overlays are incorporated 
into the slide. 

Step 10: To edit the order of the map layer images on the slide, 
click the ‘Format’ button on the Powerpoint ribbon then select 
‘Selection Pane’ (see Figure 54).

Figure 52. Pasted map layer image from QGIS.

Figure 53. Showing the ‘Set Transparent Color‘ command to remove the background of the 
map layer image.
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Step 11: Once the ‘Selection Pane’ is opened, the ‘Selection and 
visibility’ tab will appear on the right side of the screen, then the user 
can select the visibility of the images on the slide as well as edit their 
arrangement (see Figure 55).
 

Step 12: When presenting, user may apply animations for each image 
to emphasize the layers. To add transition to the images on the slide, 
simply click the map image layer under the ‘Selection and visibility 
tab’. Once the image is selected, go to ‘Animations’ then click the 
desired animation type (see Figure 56). 

Figure 54. Under format, user can open the ‘Selection Pane ‘ to easily navigate and edit each 
map layer image.

Figure 55. In the ‘Selection and Visibility’ window, user can re-arrange order of the layers, edit 
their visibility, and rename them. 
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NOTE TO THE USER: To activate the map and make it dynamic, click 
the ‘Slideshow’ button. 

Figure 57 is an example of an advocacy map showing the overlaps 
of mining tenements with forests, watersheds, and river systems in 
Mindoro. The map illustrates mining tenements sitting above forests 
and watersheds. It also shows how forests and communities will 
be affected by the mine tailings and other wastes through water 
tributaries that lead to the lowland areas. The map strongly bespeaks 
these mining operations as illegal since the areas should be protected 
against mining under the National Integrated Protected Areas System 
(NIPAS) Law. 

Figure 56. Animations can emphasize each layer during presentation.

Figure 57. A map of Mindoro showing overlaps of mining tenements with forests, watershed, 
and river systems.
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CHAPTER 3:
USING MAPS

FOR ADVOCACY

In today’s complex world, land rights defenders all over the world 
confront immense challenges in advocating their causes. Foremost of 

which is the ability to effectively share data and clearly communicate 
their message to policy makers and the public at large, given the wide 
array of available information in different mediums that are accessible 
to anyone at any given time. One strategy that may address this issue 
is the use of spatial data, carefully composed into advocacy maps. 
Maps can be a simple, yet powerful, means for communicating and 
sharing information and advocating a cause.

Developing Advocacy Maps

Land rights defenders often face very complex problems that require 
a thorough understanding of the various factors and issues that 
affect communities and threaten their land security.  The volume 
of information that is generated in the course of addressing land 
conflicts often overwhelms advocates, which sometimes makes it 
very difficult to articulate a clear statement and position. Hence, it is 
very important to be systematic in the collection of data, its analysis 
and the formulation of an advocacy statement. The following steps are 
important in developing an advocacy map for land rights defenders:
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Steps

n	 Identify the sectors, affected ecosystems, issues, and themes;
n	 State the campaign message or advocacy statement;
n	 List the data needed;
n	 Collate and organize map data;
n	 Communicate the message; and,
n	 Validate the output map with the concerned group or 

community.

Identifying the Affected Ecosystem, Sectors, and Issues

At the onset of the mapping activity, the main issue/s that will be 
addressed must be clearly identified and defined.  Local communities 
are often confronted by multiple issues arising from a land conflict 
caused by an investment or a project initiated by an adverse party. For 
instance, indigenous communities affected by a mining development 
face displacement, environmental destruction, damage to livelihood 
or agricultural areas, among other issues. The adverse effects may 
also be faced by a number of sectors. This is usually the case as large-
scale investment projects cover a wide area and its impacts affect a 
wider landscape.  Hence, a major mining activity may have an impact 
on downstream communities as it affects the sources of water and 
the agricultural areas. Moreover, the mining activity will also affect 
the integrity of the biodiversity and of any environmentally-critical 
area within the immediate coverage of the investment. In this case, 
issues raised by environmental advocates will become an integral 
part of the coverage of the advocacy map.

The Campaign Message

Once the involved sectors, the affected ecosystem, and issues to be 
addressed are clearly identified, the main campaign message should 
be clearly stated. Ranking the impacts of the multiple issues caused 
by the development project faced by the sectors is a good way of 
creating a hierarchy of the problems; it will also help in crafting the 
main advocacy message. In many instances, the negative effect on all 
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of the sectors would embody the main message. This will be common 
to most sectors and would have the highest impact on those affected 
by it. In the case of mining, the damage caused to the environment 
would be the issue that cuts across all sectors and ecosystems. The 
immediate effects particular to a sector, for example, could include: 
(1) land tenure and local communities; (2) loss and contamination 
of water which affects the agricultural sector; and, (3) damage to 
environmentally-critical areas for environmentalists.

Required Data

The extent and type of information needed to develop the advocacy 
map will be based on the issues and impacts that were earlier 
identified. In many instances, it would depend on the availability of 
data and the community’s capacity to secure, and in many instances, 
generate the spatial data critical to the advocacy work.  A checklist of 
the minimum required data, its format and possible sources will be 
helpful in systematizing the gathering data for the advocacy maps.

Data/Layer Format Source
Certificate of Ancestral 
Domain (CADT)

Hardcopy NCIP-ADO, 
AnthroWatch

CADT Shp. LandMark
Land Cover Data Shp. NAMRIA
Watersheds Shp. DENR-BMB
Protected Areas Shp. DENR-BMB
CADT Zoning Map Hardcopy NCIP-Planning
CADT Zoning Map Shp. PAFID
Groundwater flow Shp. BSWM
NPAAD Shp. BSWM
Rice Production 
Statistics

Doc. DA/PSA

Forest Cover Statistics Doc./xls DENR-FMB
Mining tenement PDF. DENR-MGB
Mining Tenement Shp. MICC
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Formulating the Message

A community workshop, wherein all of the concerned and affected 
sectors are represented, should be conducted to formulate the 
message. Focus Group Discussions (FGDs) shall be conducted for each 
sector wherein the spatial information representing their particular 
ecosystem, issues and themes shall be presented and analyzed. After 
the FGDs, each sector shall have their own sectoral statement.  A 
plenary session shall be conducted in order to synthesize all reports 
and come up with the main advocacy statement for the map.

Organizing the Map

Once all the required information has been collected, the group shall 
develop several maps wherein the various ecosystems and sectoral 
themes are represented. The advocacy map will have the agreed 
sub-themes, which are represented as individual plates or sections 
in the main map. For instance, the map could be divided into six 
subsections. These sub-sections of the advocacy map shall contain 
the main message and the agreed sectoral thematic layers, which 
represent the particular issue that affects the concerned sector.

Local Validation

The draft map containing the basic local information, sectoral 
layer with spatial data showing their issues and the main advocacy 
message, which is a result of the agreements in the plenary, will 
then be presented to community members for validation. The map 
and all of its elements should be thoroughly discussed to ensure 
its familiarity and comprehension of all sectoral representatives 
concerned. If a consensus is reached that the map represents both 
the sectoral as well as collective aspirations of the group, a resolution 
should be drafted to legitimize the map. Once this is done, the map 
may be finalized for publication.
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Communicating the message

Armed with supporting data and a powerful visual tool such as the 
map, the message shall be communicated clearly and objectively 
to the intended audiences: (a) first is the target of the advocacy 
i.e. the policymakers and the purveyors of development aggression 
(the mining, logging or other such companies engaged in extractive 
practices); and, (b) second is the general public who should be 
made aware that, even though they are not directly affected by this 
particular advocacy or situation; they are part of the larger ecosystem 
and should be concerned as well; not to mention that a similar case 
may happen or may already be happening in their backyard.

Ensuring credibility of your data

Land rights defenders face opponents who possess economic and 
political power and are often the perpetrators of development 
aggression and land grabbing against local and indigenous 
communities. Thus, it can be expected that very serious challenges will 
be mounted at every opportunity against the advocacy position of the 
affected communities and its supporters. Hence, it is very important 
to ensure the credibility of any information that is generated in any 
advocacy mapping initiative.

The following pointers are necessary in the process of developing an 
advocacy map:
n	 Data sources have been published and officially  

acknowledged.
n	 Data sources are available in the Public Domain.
n	 Data sources are cross-referenced or triangulated; at least  

three sources should mention/indicate the same spatial 
information before it is included. 
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	 Advocacy maps provide an excellent opportunity for 
communities to tell their stories and document the critical 
changes that they observe in their environment in a given 
period.

	 The development of the Tampakan advocacy map is an 
initiative that enabled the local community and support groups 
to effectively articulate to the public and policy makers their 
opposition to Sagittarius Mines, Inc. in Tampakan, South 
Cotabato, Philippines.

	 Background

	 The Tampakan Copper-Gold Project is reportedly the seventh 
largest undeveloped copper mine in the world. When 
operational, it will be one of the largest copper-gold mines 
in Southeast Asia. Owned by Glencore-Xstrata, with the 
Australian company Indophil holding a minority stake, the 
mine is operated by its local subsidiary, Sagittarius Mines, Inc. 
(SMI). The final overall mine area is estimated at around 10,000 
hectares, falling within the boundaries of four provinces (South 
Cotabato, Sarangani, Davao del Sur and Sultan Kudarat). The 
area is mostly forested and includes a substantial portion of the 
ancestral domain of an indigenous community – the Bla’ans. 
The mine’s open pit of some 500 hectares would be dug to a 
depth of 785 meters, while the topsoil stockpile would cover 
an area of five hectares and the pit ore stockpile would be 49 
hectares.

	 The company’s Environmental Impact Assessment (EIA) 
estimated that 5,000 people, mostly indigenous, would be 
directly affected and would require resettlement.  The mining 
project will directly affect five watersheds, around 4,000 
hectares of old-growth forest, and five ancestral domains.

	 “The Tampakan project has caused the murder and harassment 
of too many indigenous leaders who oppose it. For communities, 
the human rights violations and threats are one of the reasons 

The Tampakan Advocacy Map
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for their opposition to the development of the mines, second to 
their displacement and the impacts to their ancestral domains,” 
Alyansa Tigil Mina (ATM), a non-governmental organization 
supporting the communities in their struggle against SMI, 
alleged in an emailed statement.

	 As of May 2014, the Tampakan project was officially on 
“downscaled status”, after undergoing an 80 percent reduction 
in its programmed funds and staffing for 2014. It is not 
suspended nor abandoned. Glencore/Xstrata has indicated 
that they are pushing for their target of commercial operations 
by 2019. They have also committed themselves to pursuing 
completion of all their regulatory requirements, including 
securing consent from indigenous peoples and working on the 
local ban on open-pit mining.

	 Developing a Map to Articulate the Peoples Advocacy against 
the Tampakan Mining Project

	 The Social Action Center of the Marbel Diocese initiated the 
generation of spatial data critical to understanding the impact 
of the proposed mining operations of SMI in Tampakan. In 
order to challenge or refute the flood of supposedly credible 
information on the benefits and minimal impacts of the 
SMI project, the anti-mining advocates agreed to build a 
“Participatory 3D model” (P3DM) of the whole impact area, 
including a mock-up of the facilities of the proposed SMI mining 
project.

	 All critical information including the spatial data, as well as the 
schematic diagrams of the proposed mining facilities, were 
carefully analyzed and reproduced to scale. Spatial information 
composed of available data layers on protected areas, land 
cover, land tenure and cultural information from the affected 
indigenous communities were overlaid in the P3DM.

	 Local and international experts, along with community 
members and CSO partners, then collectively analyzed all  
the information generated and consolidated in the P3DM. 
The collective analysis was used to generate the consensus 
“Advocacy Position” of the anti-mining advocates. These were 
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later presented in a Provincial Consultation in Marbel, South 
Cotabato.

	 On 23 September 2009, international and local experts critiqued 
the Environmental and Social Impact Assessment (ESIA) of the 
Tampakan Mine Project in a public forum held at the South 
Cotabato Gymnasium and Cultural Center. 	

	 The Social Action Center of the Marbel Diocese and the Office 
of the Governor co-organized the activity to bring together 
the SMI/Xstrata consultants and experts from the anti-mining 
groups to present to the people how the Tampakan mining 
project will actually impact the people and environment.

	 During consultation, the SMI/Xstrata consultants explained the 
merits of the mining operation and the supposed benefits it 
will give to the host communities. In response, Clive Wicks and 
Filipino experts, Atty. Ipat Luna and Kail Zingapan of Philippine 
Association for Intercultural Development (PAFID), presented 
their evaluation and discussed the real risks of the project that 
seemed to be covered up in the massive Environmental Impact 
Statement (EIS) and Environmental Impact Assessment (EIA) 
documents.	

	 The anti-mining advocates argued that the Tampakan mine 
development, which covers an area of approximately 10,000 
hectares, will have a devastating effect on the environment. 
The development will cut down almost 4,000 hectares of 
forests, including old growth forests. It will contaminate the 
water source of communities on six rivers with arsenic and 
acid mine drainage. The Mal river will be the worst affected as 
many streams in its catchment will be destroyed and replaced 
by the tailings dam. This will have a severe impact to numerous 
downstream communities as the Mal River, the region’s biggest 
river system, is the main source of irrigation for the agricultural 
sector in the neighboring province of Davao del Sur.	

	 Kail Zingapan, who worked with local indigenous communities 
to produce an impressive 3-D map of the Koronadal Valley and 
the Tampakan watersheds, explained what the mining project 
would mean for the affected communities.	
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	 In presenting the “People’s Map”, Zingapan asserted: “This is 
the People’s Map, we did not invent this. The people pointed 
out to us where their lands are located and we plotted them on 
the map. We showed them the outcome and they saw that the 
mine development area covers their ancestral lands; it seems 
not all of them were consulted or correctly informed of the 
risks by SMI”.	

	 People were shocked as Zingapan placed the supposed mine 
tailings dam area on top of the hill and the fresh water dam 
right where Mal River is located. “This is your land where you 
live and get your food and everyday needs. It is up to you now 
if you want to see this land devastated and taken away from 
you,” she said in the Visayan dialect.	

	 Environmental lawyer Ipat Luna, on the other hand, explained 
her legal evaluation of the EIS, “The EIS inadequately sets out 
the direct losses to be caused by the project and has gaps in 
terms of other legal permits and compliance.”	

	 She further added, “The Stakeholders’ Development 
Framework fails to appreciate the unique cultural identity of 
the B’laan and merely enumerates standard social development 
interventions.”

	 After the presentation of SMI’s EIA and its subsequent critique, 
Bishop Dinualdo Gutierrez of the Diocese of Marbel said: 
“No mining project will ever be good for us. Let us continue 
to support the South Cotabato Environmental Code that bans 
open pit mining.” The Bishop further reiterated that there is no 
need for the Sangguniang Panlalawigan (Provincial Council) to 
review the said code.	

	 Alyansa Tigil Mina (ATM) National Coordinator Jaybee Garganera 
said, “Unlike SMI/Xstrata who are here to get the approval of the 
people to mine their lands, the experts and non- governmental 
organizations are here because the communities requested our 
help. We are here also because we believe that the claimed 
benefits of this mining project are clearly outweighed by the 
impacts it will bring to water, agriculture, forests, biodiversity 
and communities.”
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	 After the presentation of the mining opposites, SMI/Xstrata 
consultants found it hard to convince the people that their 
project will not impact negatively on many lives.

	 After two hours of open forum, Governor Arthur Pingoy, Jr. 
concluded and assured the people: “As the governor of this 
province, I will implement the (Provincial Environmental Code) 
Ordinance. There will be no open-pit mining in the province 
unless there is an order from the Courts. I am duty bound to 
implement the Ordinance.”  He added that the forum was 
primarily organized to allow the Sangguniang Panalalawigan to 
arrive at an informed decision in reviewing the provision of the 
Provincial Environment Code banning open pit mining.

	 More than 6,000 people went to listen and ask questions at the 
forum. Most of them were able to go inside, while some people 
stayed outside due to lack of space. They were still able to follow 
the proceedings as a big screen was set-up and broadcast what 
was happening inside. Information on the Tampakan P3DM 
has been digitized and put in a GIS making further widespread 
dissemination possible. 

Figure 58. A map showing the mining industry in Tampakan, South Cotabato, Philippines, 
and its potential threats to sustainable development.

To view further examples of maps used for advocacy, visit the following:
• Using P3DM for advocacy (https://www.youtube.com/watch?v=q7Lfrpn6VsU)
• Anti-mining advocacy maps
(http://www.piplinks.org/maps.html)
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Annex A
Sample PRS92 Certification of Tie Point Coordinates
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Annex B
Annex 7 of DENR Memorandum Circular 2010-16 

Manual on Land Surveys

DENR Memorandum Circular 2010-16 Manual on Land Surveys
Annex VII
pages 15-16

Annex VII. PPCS-TM Zone Assignment of Provinces
The assignment of provinces into the map projection zones of the 
PPCS-TM shall be as follows:

Province PPCS-TM Zone

a. Cordillera Administrative Region (CAR)

1) Abra Zone No. III

2) Benguet Zone No. III

3) Ifugao Zone No. III

4) Mountain Province (Bontoc) Zone No. III

5) Kalinga Zone No. III

6) Apayao Zone No. III

b. National Capital Region (NCR)

1) Metro Manila Zone No. III

c. Region No. I  Northwestern Luzon

1) Ilocos Norte Zone No. III

2) Ilocos Sur Zone No. III

3) La Union Zone No. III

4) Pangasinan Zone No. III

d. Region No. II Northeastern Luzon

1) Batanes Zone No. III

2) Cagayan Zone No. III

3) Isabela Zone No. III

3a) Municipalities West of  122° E Longitude Zone No. III

3b) Municipalities East  of  122° E Longitude Zone No. IV

4) Nueva Vizcaya Zone No. III

5) Quirino Zone No. III

e. Region No. III Central Luzon

1) Bataan Zone No. III

2) Bulacan Zone No. III

3) Nueva Ecija Zone No. III
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4) Pampanga Zone No. III

5) Tarlac Zone No. III

6) Zambales Zone No. III

f. Region No. IV Southern Tagalog  

1). Aurora Zone No. III

2.) Batangas Zone No. III

3)  Cavite Zone No. III

4)  Laguna Zone No. III

5)  Marinduque Zone No. III

6)  Occidental Mindoro Zone No. III

7)  Oriental Mindoro Zone No. III

8)  Palawan

Palawan Central Meridian 118° 30’ E Zone I

9)  Quezon Province

9a) Municipalities East of 122° E Longitude                      Zone No. IV

9b) Municipalities West of 122° E Longitude                 Zone No. III

9c) Polillo Islands                                                        Zone No. III

10) Rizal Zone No. III

11) Romblon Zone No. IV

g. Region No. V Bicol

1) Albay Zone No. IV

2) Camarines Norte Zone No. IV

3) Camarines Sur Zone No. IV

4) Catanduanes Zone No. IV

5) Masbate Zone No. IV

6) Sorsogon Zone No. IV

h. Region No. VI Western Visayas

1) Aklan Zone No.  IV

2) Antique Zone No. IV

3) Capiz Zone No. IV

4) Ilo-ilo Zone No. IV

5) Negros Occidental Zone No. IV

6) Guimaras Zone No. IV

i. Region No. VII Central Visayas

1) Bohol Zone No. V

2) Cebu Zone No. IV

a. Camotes Islands Zone No. V

3) Negros Oriental Zone No. IV

4) Siquijor Zone No. IV

j. Region No. VIII Eastern Visayas
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1) Eastern Samar Zone No. V

2) Leyte Zone No. V

3) Northern Samar Zone No. V

4) Samar (Western Samar) Zone No. V

5) Southern Leyte Zone No. V

6) Biliran Zone No. V

k. Region No. IX Western Mindanao

1) Zamboanga Del Norte Zone No. IV

2) Zamboanga Del Sur Zone No. IV

3) Zamboanga Sibugay Zone No. IV

l. Region No. X Northern Mindanao

1) Bukidnon Zone No. V

2) Camiguin Zone No. V

3) Lanao Del Norte Zone No. V

4) Misamis Occidental Zone No. IV

5) Misamis Oriental Zone No. V

m. Region No. XI Southern Mindanao

1) Compostela Valley Zone No. V

2) Davao Del Norte Zone No. V

3) Davao Del Sur Zone No. V

4) Davao Oriental Zone No. V

n. Region XII Central Mindanao

2) North Cotabato Zone No. V

3) Sarangani Zone No. V

3) South Cotabato Zone No. V

4) Sultan Kudarat Zone No. V

o. Region No. XIII (Caraga)

1) Agusan Del Norte Zone No. V

2) Agusan Del Sur Zone No. V

3) Dinagat Islands Zone No. V

4) Surigao Del Norte Zone No. V

5) Surigao Del Sur Zone No. V

p. Autonomous Region of Muslim Mindanao (ARMM)

1) Basilan Zone No. IV

2) Lanao Del Sur Zone No. V

3) Maguindanao Zone No. V

5) Tawi-tawi Zone No. III

6) Sulu Zone No. III
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The  National Engagement Strategy (NES)  was initiated as 
a response to the need for the International Land Coalition 
(ILC) to engage in selected countries in a focused, coherent, 
and coordinated manner that emerged from past lessons. ILC 

has been a development partner of Philippine CSOs engaged in promoting asset reform and 
pointing out the deficiencies of policies in current land and resource rights.
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strengthen access to and control of land and other natural resources in rural sectors.
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to land, agrarian reform and sustainable development for the rural 
poor are addressed in national and regional development agenda. The 
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This resource book is the second volume publication on Community Mapping and 
Participatory Geographic Information System (PGIS) which aims to equip the users with 
the necessary knowledge, attitude and skills on this subject area. It is intended for land 
rights defenders, institutions advocating for land rights, development practitioners, and 
communities to defend their rights to land and the sustainable use of natural resources.

Inspired by the pioneering work of the Philippine Association for Intercultural 
Development, Inc. (PAFID) in PGIS mapping in the country, this publication is designed 
to impart the key concepts of community mapping and the basics of PGIS, with the view 
that the application of PGIS technology contributes to securing legal recognition of the 
indigenous communities over their traditional territories and resources. 

This volume is designed to impart on the “how-tos” for the production of digital maps 
useful in advancing the land rights agenda of rural communities, particularly indigenous 
communities and smallholder farmers in Southeast Asia.


